
Experiment CP-1: The Electrocardiogram (ECG) and the Pulse

Background

The cardiac cycle involves the sequential contractions of the atria and the ventricles which are triggered
by action potentials in the myocardial cells. The combined electrical activity of the myocardial cells 
produces electrical currents that spread through the body fluids. These currents are large and detectable 
by recording through electrodes placed on the skin. The regular pattern of signals produced by the heart
is called the electrocardiogram or ECG (Figure CP-1-B1).

Figure CP-1-B1: ECG recording displayed in the Main window with labels showing the P, QRS, and T 
waves. 

The components of the ECG (Figure CP-1-B1) are correlated to electrical activity in the atria and 
ventricles such that:

• Atrial depolarization produces the P wave.

• Atrial repolarization and ventricular depolarization produce the QRS complex.

• Ventricular repolarization produces the T wave. 

The depolarization of the myocardial cells in the ventricle causes the ventricles to contract and force 
blood into the major arteries of the circulatory system in a pulsatile manner. The pulses of blood 
moving in arteries can be recorded using a device known as a plethysmograph. 

In this experiment, you will simultaneously record a subject's single lead ECG and the pulse wave in 
the finger. This exercise will demonstrate the time delay that occurs between the electrical events in the
heart and mechanical events in the circulatory system. You will also examine the effects of temperature 
on peripheral circulation.
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Equipment Required

PC or Macintosh computer

IX-ELVIS 

USB cable

Power supply

Red, black, and green ECG lead wires

PTN-104 Pulse plethysmograph

Stethoscope

Alcohol swabs

Disposable ECG electrodes

Ice, cold and hot water, plastic bags

IX-ELVIS Setup

1. Place the IX-ELVIS unit on the bench, close to the computer. 

2. Connect the IX-ELVIS to the computer with the supplied USB cable. 

3. Insert the power plug into the rear of the IX-ELVIS and plug the transformer into the electrical 
outlet. Turn on the power switches on the rear and on the upper right side of the top of the unit 
and confirm that the LEDs are illuminated.

Start the Software

1. Click on the LabScribe shortcut on the computer’s desktop to open the program. If a shortcut is 
not available, click on the Windows Start menu, move the cursor to All Programs and then to 
the listing for iWorx. Select LabScribe from the iWorx submenu. The LabScribe Main window 
will appear as the program opens.

2. On the Main window, pull down the Settings menu and select Load Group.

3. Locate the folder that contains the settings group, ELVISNI.iwxgrp. Select this group and click 
Open.

4. Pull down the Settings menu again. Select the ECGPulse-LS2 settings file.

5. After a short time, LabScribe will appear on the computer screen as configured by the 
ECGPulse-LS2 settings.

6. The settings used to configure the LabScribe software and the IX-ELVIS for this experiment are
programmed on the Preferences Dialog window which can be viewed by selecting Preferences 
from the Edit menu on the LabScribe Main window.

ECG Cable and Pulse Transducer Setup

1. Locate the PTN-104 pulse plethysmograph (Figure CP-1-S1) and the ECG electrode lead wires 
(Figure CP-1-S2).

2. Plug the mini-DIN connector to the PTN-104 into the Channel 3 input of the IX-ELVIS (Figure 
CP-1-S3).
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3. Insert the connectors on the red, black, and green electrode lead wires into the matching sockets
of Channel 1 of the IX-ELVIS (Figure CP-1-S3).

4. Instruct the subject to remove all jewelry from their wrists and ankles.

Figure CP-1-S1: The PTN-104 pulse plethysmograph.

Figure CP-1-S2: The ECG lead wires snapped to disposable electrodes..
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Figure CP-1-S3: The ECG leads and pulse transducer connected to an IX-ELVIS.

5. Use an alcohol swab to clean and scrub a region with little or no hair, on the inside of the 
subject’s right wrist. Let the area dry.

6. Remove a disposable ECG electrode from its plastic shield, and apply the electrode to the 
scrubbed area on the wrist.

7. Repeat Steps 5 and 6 for the inside of the left wrist and the inside of the right ankle. 

8. Snap the lead wires onto the electrodes, so that:

• the red (+1) lead is attached to the left wrist,

• the black (-1) lead is connected to the right wrist,

• the green (C or ground) lead is connected to the right leg.

9. Place the plethysmograph on the volar surface (where the fingerprints are located) of the distal 
segment of the subject’s middle finger or thumb, and wrap the Velcro strap around the end of 
the finger to attach the transducer firmly in place.

10. Instruct the subject to sit quietly with their hands in their lap. If the subject moves, the ECG 
trace will move off the top or bottom of the screen. If the subject moves any muscles in the 
arms or upper body, electromyograms (EMGs) from the muscles will appear on the ECG 
recording as noise.
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Exercise 1: The ECG and the Pulse in a Resting Subject

Aim: To measure and correlate the ECG and the pulse in a resting individual.

Procedure

1. Click on the Record button, located on the upper right side of the LabScribe Main window 
(Figure CP-1-L1). The signal should begin scrolling across the screen.

Note: If the user clicks the Record button and there is no communication between the IX-
ELVIS and computer, an error window will appear in the center of the Main window. Make 
sure the IX-ELVIS is turned on and connected to the USB port of the computer. Click OK 
and select the Find Hardware function from the LabScribe Tools menu. 

2. Click on the AutoScale button at the upper margin of the ECG, Pulse, and Pulse Integral 
channels. Your recording should look like Figure CP-1-L1. 

• If the signal on either the ECG or the Pulse channel is upside down when compared to trace 
in Figure CP-1-L1, click on the downward arrow to the left of the channel title and select 
the Invert function. The trace should now look similar to the one in the figure

• If a larger ECG signal is required, the electrodes should be moved from the wrists to the 
skin immediately below each clavicle. 

• If the pulse signal is small or noisy, adjust the tension on the strap holding the pulse 
plethysmograph to the finger.

3. When you have a suitable trace, type “ <Subject’s Name> Resting ECG/Pulse” in the Mark box 
to the right of the Mark button. Press the Enter key on the keyboard to attach the comment to 
the data. Record for a minute or two.

4. Click Stop to halt recording. Your data may look like Figure CP-1-L1.

Figure CP-1-L1: ECG, pulse, and pulse integral displayed on the Main window. The arrow is placed 
above a dichrotic notch.
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5. Select Save As in the File menu, type a name for the file. Choose a destination on the computer 
in which to save the file. Designate the file type as *.iwxdata. Click on the Save button to save 
the data file.

Data Analysis 

1. Scroll through the recording and find a section of data with five or six exemplary ECG/pulse 
cycles in succession.

2. Use the Display Time icons to adjust the Display Time of the Main window to show at least 
four complete ECG/Pulse cycles on the Main window. Four adjacent ECG/Pulse cycles can also
be selected by:

• Placing the cursors on either side of a group of four complete ECG/Pulse cycles; and

• Clicking the Zoom between Cursors button on the LabScribe toolbar to expand the segment 
with the four selected ECG/Pulse cycles to the width of the Main window.

3. Click on the Analysis window icon in the toolbar (Figure CP-1-L2) or select Analysis from the 
Windows menu to transfer the data displayed in the Main window to the Analysis window 
(Figure CP-1-L3).

Figure CP-1-L2: The LabScribe toolbar.

4. Look at the Function Table that is above the uppermost channel displayed in the Analysis 
window. The names of the mathematical functions used in the analysis, V2-V1 and T2-T1, 
appear in this table. The values for V2-V1 and T2-T1 from each channel are seen in the table 
across the top margin of each channel. In this exercise you will only need to record the values 
for T2-T1.

5. Once the cursors are placed in the correct positions for determining the time intervals on each 
ECG/Pulse cycle, the values of the time intervals can be recorded in the online notebook of 
LabScribe by typing their names and values directly into the Journal, or on a separate data table.

6. The functions in the channel pull-down menus of the Analysis window can also be used to enter
the names and values of the parameters from the recording to the Journal. To use these 
functions:

• Place the cursors at the locations used to measure the amplitudes and period of the 
ECG/Pulse cycle.

• Transfer the names of the mathematical functions used to determine the amplitudes and time
interval to the Journal using the Add Title to Journal function in the ECG Channel          
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pull-down menu.

• Transfer the values for the amplitudes and beat period to the Journal using the Add Ch. Data
to Journal function in the ECG Channel pull-down menu.

Figure CP-1-L3: ECG, pulse and pulse integral displayed on the Analysis window with cursors in 
place to measure the R-Pulse interval with the T2-T1 function.

7. Use the mouse to click on and drag the cursors to specific points on the ECG/Pulse recording to 
measure the following:

• The beat period, which is the time interval between two adjacent R waves (Figure CP-1-L3).
To measure the beat period, place one cursor on the peak of an R wave and the second 
cursor on the peak of the adjacent R wave. The value for T2-T1 on the ECG channel is the 
beat period. Measure the beat period for two additional pairs of R waves. 

• The R-Pulse interval, which is the time interval between the peak of the R wave and the 
peak of the pulse wave that follows the R wave (Figure CP-1-L3). To measure this interval, 
place one cursor on the peak of an R wave and the second cursor on the peak of the pulse 
wave to its right. The value for T2-T1 on any channel is this interval. Measure this interval 
for two additional ECG/Pulse cycles.

8. Calculate the following values and record your results into the Journal or on a separate data 
table:

• The average beat period, in seconds/beat.

• The heart rate, which is expressed in beats per minute and calculated from the average beat 
period by using the following equation:

Heart Rate (beats/minute) = 60 seconds/minute/# seconds/beat

• The average R-Pulse interval.
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Questions

1. What electrical and mechanical events take place during the R wave?

2. What events take place in the cardiovascular system during the R and pulse waves?

3. The signal recorded on the Pulse channel is rate of change of the blood pressure entering the 
subject’s finger tip. When this signal is integrated, the waveform displayed on Pulse Integral 
channel is similar to an arterial pressure curve. Is there a short plateau or dip during each cycle 
displayed on the Pulse Integral channel? This plateau or dip is called the dichrotic notch. If you 
optimized the tension on the plethysmograph strap to record a large, clean pulse wave from 
your subject, you should see a dichrotic notch on the Pulse Integral channel.

4. What event recorded on the ECG channel corresponds to the dichrotic notch? What causes a 
dichrotic notch?

Exercise 2: The ECG and the Pulse in Other Subjects

Aim: To measure and correlate the ECG and the pulse in other subjects.

Procedure

Repeat Exercise 1 on other subjects. 

Data Analysis 

Analyze the data for each subject using the same techniques used in Exercise 1.

Questions

1. Is the time interval between the R wave and the peak of the pulse wave the same for each 
subject? Does this time interval differ with heart rate?

2. Do you see any differences in the size or shape of dichrotic notches from different subjects? 
Remember: the tension on the plethysmograph strap affects the shape of the pulse recording.

3. Is the time interval between the peak of the pulse wave and the bottom of the dichrotic notch the
same for each subject?

4. What factors would affect the shape or position of the dichrotic notch?

Exercise 3: The Effect of Cold on the Pulse

Aim: To measure the effects of cold on the pulse and heart rate.

Procedure

1. Attach the plethysmograph to the middle finger of the subject’s left hand. Instruct the subject to 
sit quietly with their hands in their lap.

2. Click on the Record button. The signal should begin scrolling across the screen.

3. Click on the AutoScale button at the upper margin of the ECG, Pulse, and Pulse Integral 
channels. Your recording should look like Figure CP-1-L3. Use the same techniques used in 
Exercise 1 to display the signals properly.
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4. When you have a suitable trace, type “<Subject’s Name> RoomTempECG/Pulse” in the Mark 
box to the right of the Mark button. Press the Enter key on the keyboard to attach the comment 
to the data. Record for a minute or two.

5. Type “Cold ECG/Pulse” in the Mark box to the right of the Mark button. Place a bag containing
a mixture of ice and cold water on the subject’s left forearm. At the same time, press the Enter 
key on the keyboard to attach the comment to the data. Record for two minutes while the cold 
pack is on the subject’s forearm.

6. Type “Remove” in the Mark box. Simultaneously remove the ice bag and press the Enter key on
the keyboard.

7. Record for an additional two minutes; then, click Stop to halt recording.

8. Select Save in the File menu on the LabScribe window.

Data Analysis

1. Scroll through the recording and find a section of data with four or five exemplary ECG/Pulse 
cycles, in succession, that were recorded at room temperature.

2. Use the Display Time icons, or the cursors and the Zoom between Cursors button, to adjust the 
Display Time of the Main window to show at least four complete ECG/Pulse cycles on the 
Main window.

3. Click on the Analysis window icon in the toolbar (Figure CP-1-L2) to transfer the data 
displayed in the Main window to the Analysis window (Figure CP-1-L4).

4. Look at the Function Table in the Analysis window and make sure the mathematical functions 
used in the analysis, V2-V1 and T2-T1, appear.

Figure CP-1-L4: ECG, pulse and pulse integral displayed on the Analysis window with cursors in 
place to measure the pulse amplitude with V2-V1 function.
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5. Once the cursors are placed in the correct positions for determining the amplitude and time 
intervals, transfer the names and values of the parameters measured in the Analysis window to 
the Journal using one of the two techniques described in Exercises 1, or transfer the values to a 
separate data table.

6. Use the mouse to click on and drag the cursors to specific points on the ECG/Pulse recording to 
measure the following:

• The pulse wave amplitude: To measure the pulse wave amplitude, place one cursor on the 
baseline that precedes the pulse wave and the second cursor on the peak of the pulse wave. 
The value for V2-V1 on the Pulse channel is this amplitude. Determine the pulse amplitude 
for three pulse waves.

• The beat period: Measure the time between two adjacent R waves using the same technique 
employed in Exercises 1 and 2. Determine the beat period for three ECG/Pulse cycles.

• The R-Pulse interval: Measure the time between the peak of the R wave and the peak of the 
pulse wave using the same technique employed in Exercises 1 and 2. Determine this interval
for three ECG/Pulse cycles.

7. Repeat Steps 5 and 6 for the data at 1 and 2 minutes into the cooling period, and at 1 and 2 
minutes into the rewarming period

8. Calculate the following values and type your results into the Journal or on a separate data table:

• The average pulse wave amplitude while the forearm was at room temperature, cooled for 1 
and 2 minutes, or rewarmed for 1 and 2 minutes.

• The heart rate while the forearm was at room temperature, cooled for 1 and 2 minutes, or 
rewarmed for 1 and 2 minutes.

• The average R-Pulse interval while the forearm was at room temperature, cooled for 1 and 2
minutes, or rewarmed for 1 and 2 minutes.

Questions

1. What effect does cooling have on the amplitude of the pulse wave? 

2. Does cooling of the forearm affect the heart rate, or the time interval between the R wave and 
the peak of the pulse wave?

3. Through what mechanism does cooling affect the peripheral circulation?

4. What other factors may affect peripheral circulation?

Exercise 4: The Effect of Heat on the Pulse

Aim: To measure the effects of heat on the pulse and heart rate.

Procedure

1. Move the plethysmograph to the middle finger of the subject’s right hand.
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2. Follow the directions used in Exercise 3 to do an experiment on the right forearm of the subject 
with a bag of warm water. Mark the recording to indicate when the bag of warm water was 
applied and removed from the forearm.

Questions

1. What effect does warming have on the amplitude of the pulse wave? 

2. Does warming of the forearm affect the heart rate, or the time interval between the R wave and 
the peak of the pulse wave?

3. Through what mechanism does warming affect the peripheral circulation?
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